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Whether you are just thinking about starting your own firm or have already started it, the business plan can be a great benefit. As your management skills increase so will the number of jobs you can effectively control. The careful completion of this plan may point out problems and limitations of your operation. This is important. To be a successful contractor you must not only know your business thoroughly, but also know your limits and seek professional advice in these areas.
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Starting Construction Company Business Plan (PDF)

Starting a construction business is an exciting venture that holds immense potential for profit and success. This industry is currently experiencing a significant upswing, with a soaring demand for construction services. As our cities expand and infrastructure projects multiply, the opportunities in construction are more abundant than ever before. In recent years, the world has witnessed a construction boom, driven by the growing need for residential properties, commercial spaces, and vital infrastructure developments. In this article, we will explore the ins and outs of launching a construction enterprise, unraveling the key considerations and steps required to navigate the path towards building a successful and thriving construction business in a market that shows no signs of slowing . Thus this article will outline how to start a construction business, and the construction company business plan (PDF, Word & Excel).
Selecting the right location is a pivotal decision when starting a construction business. The geographical area you choose will significantly impact the clientele you can reach, the types of projects you can undertake, and the level of competition you will face. The key is to strike a balance between proximity to potential clients and access to a skilled workforce and suppliers. Urban areas often offer a steady flow of construction projects, from commercial buildings to residential developments, but they also come with higher costs and stiffer competition. On the other hand, rural or suburban settings might offer lower competition and potentially lower overheads, but you may need to travel farther to access clients and resources.
Conduct thorough market research to identify the locations that align best with your business goals and resources. Moreover, consider the regulatory environment in your chosen location. Construction businesses are subject to various local, state, and federal regulations, and these can vary significantly from one place to another. You’ll need to understand zoning laws, building codes, and permitting requirements, as they can affect project timelines and costs. Additionally, establishing a strong network in your chosen location, with connections to local government offices, suppliers, and industry peers, can be invaluable for navigating these regulatory challenges and finding opportunities for growth. So, whether you decide on the bustling city streets or the tranquil suburbs, making a well-informed decision about your construction business’s location is a crucial step on your path to success.
Premises & Offices
The choice of premises and offices for your construction business is more than just a matter of bricks and mortar; it’s about setting the foundation for your company’s operations and growth. Many construction businesses start small, often from the owner’s home or a leased office space. As your business expands, your premises should be scalable to accommodate your growing team, equipment, and storage needs. Consider the layout of the building, making sure it’s practical for your daily operations and that it complies with safety and zoning regulations. Proximity to project sites and clients can also be a significant factor, as it can save time and costs on transportation.
Investing in a dedicated yard or storage facility can be essential, especially if your construction projects involve large machinery and materials. A well-organized yard can help streamline your operations and ensure that your equipment and materials are secure and easily accessible. Whether you choose to lease or buy, your premises should align with your long-term business goals and be adaptable to future growth. So, whether you’re starting in a small office or managing a sprawling facility, selecting the right premises and buildings is a pivotal step in building a solid foundation for your construction business. The cost of acquiring or leasing the premises should be included in the construction business plan.
In the construction industry, mobility is key, and your choice of vehicles can greatly influence the efficiency and effectiveness of your operations. Whether you’re transporting heavy equipment to job sites or meeting with clients and suppliers, having the right fleet of vehicles is crucial. Consider the specific needs of your business. If your projects involve transporting large machinery and materials, a fleet of trucks, flatbeds, or specialized construction vehicles might be essential. On the other hand, for a smaller operation, a reliable set of work vans or pickup trucks could suffice. Ensure that your vehicles are well-maintained, fully insured, and compliant with safety regulations to protect your team and your investments.
When selecting vehicles for your construction business, factor in fuel efficiency, maintenance costs, and durability. You’ll want vehicles that can withstand the wear and tear of construction work and provide a solid return on investment. Additionally, branding your vehicles with your company logo and contact information can serve as a moving advertisement for your business, enhancing visibility and credibility in your local area. So, from the pickup trucks that transport your crew to the heavy-duty equipment that gets the job done, your choice of vehicles plays a critical role in the success of your construction business. The construction company business plan should cater for the costs of acquiring the vehicles.
Machinery & Equipment
In the construction industry, the right machinery and equipment are the lifeblood of your business. From bulldozers and cranes to concrete mixers and power tools, the tools you use can make or break the success of your projects. Investing in high-quality, well-maintained machinery is not just about efficiency but also safety. Regular maintenance and inspections are essential to keep your equipment running smoothly and to prevent costly downtime. Keep an inventory of your equipment, create a maintenance schedule, and have a contingency plan in case of unexpected breakdowns to ensure that your projects stay on track. Your choice of machinery should also align with the types of projects you plan to undertake.
Different construction specialties require different equipment. For instance, if you’re focused on residential construction, you may need equipment like excavators and skid-steer loaders, while commercial projects may call for larger cranes and specialized tools. You can also consider renting or leasing equipment when needed rather than purchasing everything outright. This flexibility can help you adapt to changing project requirements and manage costs more effectively. So, from the smallest hand tools to the largest earth-moving machines, your selection of machinery and equipment is a critical component of your construction business’s ability to deliver quality work on time and within budget. The cost of purchasing the equipment should be included in the construction company business plan.
The range of services your construction business offers is a defining factor in your identity and success within the industry. The construction sector is incredibly diverse, and you can choose to specialize in various areas based on your team’s expertise and your business goals. Residential construction, for instance, involves building and renovating homes, while commercial construction focuses on commercial buildings like offices, retail spaces, and warehouses. Each sector has its unique demands, regulations, and client expectations. As a construction business owner, you may offer a variety of services, such as general contracting, design and build, renovation, new construction, and specialized services like electrical or plumbing work.
Your niche and expertise will shape your branding and marketing efforts. Consider the needs and demands of your target market, and tailor your services to meet them effectively. It’s essential to strike a balance between offering specialized expertise and diversifying your services to reach a broader audience. Specializations might include environmental construction, focusing on sustainable and eco-friendly building practices, or civil construction, involving infrastructure projects like bridges and roads. Industrial construction centers on factories and manufacturing facilities, while institutional construction pertains to educational and healthcare facilities. As you establish your construction business, it’s vital to carefully define the services you provide and identify the sectors or specializations that align with your skills and market demand. This strategic decision will help you carve out a niche in the industry and attract clients seeking your specific expertise.
Staff & Management
The construction industry thrives on the collective effort and expertise of the people involved, making your choice of staff a critical component of your business’s success. Hiring the right team members, from skilled laborers to project managers, is essential for executing projects efficiently and meeting your clients’ expectations. Seek individuals with the necessary qualifications and experience, as well as a strong work ethic and commitment to safety. Training and ongoing professional development should also be a priority to ensure that your staff remains up-to-date with industry best practices. In addition to hiring, consider the size and structure of your workforce.
For smaller businesses, cross-training employees to handle multiple roles can provide flexibility, while larger operations may benefit from specialized positions to streamline tasks and responsibilities. Moreover, in a dynamic industry like construction, it’s common to employ part-time or project-specific staff, ensuring that you can scale your team up or down as project demands fluctuate. This approach allows for cost-effective flexibility, especially when additional labor is required for specific tasks or phases of construction projects. The salaries for all your employees should be catered for in your construction business plan.
In parallel, strong management is essential to orchestrate all these moving parts. Effective leadership ensures that projects are delivered on time and within budget, and that safety and regulatory compliance are maintained. It involves setting clear expectations, providing guidance, and fostering a culture of accountability. As your construction business grows, consider the need for departmental specialization, from a dedicated HR and accounting team to specialized project management roles. The right blend of staff and effective management creates a symbiotic relationship, leading to successful project outcomes and long-term business sustainability.
The market for construction services is undeniably vast, presenting a plethora of opportunities for your construction business to thrive. From towering skyscrapers to residential homes, the demand for construction projects continues to be robust and varied. The potential customers for your construction business span a wide spectrum, including individual homeowners, property developers, real estate investors, businesses, institutions, and government agencies. Each of these customer segments offers distinct projects and requirements, making it crucial to identify and target those that align best with your expertise and business goals.
For instance, homeowners may seek your services for home renovations or building a new house, while property developers and real estate investors often require your expertise in constructing multi-unit housing or commercial properties. Businesses, including retailers, offices, and warehouses, are potential clients for commercial construction projects, and institutions like schools, hospitals, and government agencies frequently undertake infrastructure and facility improvements. Understanding the diverse range of potential customers in this expansive market empowers you to tailor your approach to meet their specific needs and seize the myriad opportunities that the construction industry offers.
Pre-Written Construction Company Business Plan (PDF, Word And Excel): Comprehensive Version, Short Funding/Bank Loan Version and Automated Financial Statements
For an in-depth analysis of the construction company business, we encourage you to purchase our well-researched and comprehensive construction business plan. We introduced the business plans after discovering that many were venturing into the construction business without enough knowledge and understanding of how to run the business, lack of understanding of the financial side of the business, lack of understanding of : the industry, the risks involved , costs and profitability of the business; which often leads to disastrous losses.
The StartupBiz Global construction company business plan will make it easier for you to launch and run your construction business successfully, fully knowing what you are going into, and what’s needed to succeed in the business. This is a complete business plan for a construction company. It will be easier to plan and budget as you will be aware of all the costs involved in setting up and running the construction business.
Uses of the Construction Business Plan (PDF, Word And Excel)
The construction business plan can be used for many purposes including:
	Raising capital from investors/friends/relatives
	Applying for a bank loan
	Start-up guide to launch your construction business
	As a construction company business proposal
	Assessing profitability of the construction business
	Finding a business partner
	Assessing the initial start-up costs so that you know how much to save
	Manual for current business owners to help in business and strategy formulation

Contents of the Construction Company Business Plan (PDF, Word And Excel)
The business plan for construction includes, but not limited to:
	Marketing Strategy
	Financial Statements (monthly cash flow projections, income statements, cash flow statements, balance sheets, break even analysis, payback period analysis, start-up costs, financial graphs, revenue and expenses, Bank Loan Amortization)
	Industry Analysis
	Market Analysis
	Risk Analysis
	SWOT & PEST Analysis
	Operational Requirements
	Operational Strategy
	Why some people in the construction business fail, so that you can avoid their mistakes
	Ways to raise capital to start your construction business

The construction company business plan package consists of 4 files
	Construction Company Business Plan – PDF file (Comprehensive Version – 97 Pages)
	Construction Company Business Plan – Editable Word File (Comprehensive Version – 97 Pages)
	Construction Company Business Plan Funding/Bank Loan Version- Editable Word File (Short version for applying for a loan/funding – 47 pages)
	Construction Company Business Plan Automated Financial Statements – (Editable Excel File)

The business plan can be used in any country and can be easily edited. The financial statements are automated. This implies that you can change eg the costs, salaries etc, and all the other financial statements will automatically adjust to reflect the change. 
Click below to download the Contents Page of the Construction Company Business Plan (PDF)

Testimonial 4
The business plan which I purchased from your website saved me TIME and MONEY! The layout of the business plan was excellent. The financial statements were detailed and easy for me to edit. I will come back to purchase another business plan soon.
Testimonial 7
I found Startupbiz Global online when I was in desperate need of a business plan. I was overwhelmed by the quality of the business plan, it’s comprehensive and well researched! I did not have to wait to get the business plan, I got it instantly after payment. I highly recommend Startupbiz Global, and would happily use them again in the future.
Testimonial 6
I purchased a business plan from you, and I’m glad to inform you that I was able to get my loan, and I’m starting my poultry farming business on the 1 st of July. This was made possible because of your business plan. Thank you very much, you made my dream come true.
Testimonial 8
Just wanted to say I am very happy with the business plan and I will gladly recommend your products, thank you very much and have a great day.
Testimonial 3
I was extremely lucky to come across StartupBiz Global. Their business plan exceeded my expectations, and most importantly I was able to secure a loan from my bank. Thank you guys, now my dreams are coming true!
Testimonial 1
StartupBiz Global provided a very professional and comprehensive business plan which I used for my business. The business plan was easy to edit, and I was able to get the funding which I wanted. I highly recommend their business plans.
Testimonial 2
Many thanks for your incredibly efficient service and thorough business plan. I am very impressed with the business plan. Before I bought the business plan, I tried to do my own business plan – it was such a nightmare and it turned out badly, also not to mention the stress it caused me. I wish I knew about your website earlier!
Testimonial 5
I was able to understand the business side of farming because of your business plan. You did extensive research; the business plan was well prepared and fully detailed.  It made everything clear, and I have somewhere to start now. I am confident that I am going to succeed in my business because of the guidance from your business plan.
Get the Construction Company Business Plan (PDF, Word And Excel)
Click Buy Now  below to purchase using Paypal, Credit Card, or Debit Card. After you have purchased, you will immediately see the download link for the business plan package on the screen. You will also immediately get an email with the business plan download link. The Pre-written business plan package (PDF, Word, and Excel) costs $30 only!

If you want to purchase multiple business plans at once then click here: Business Plans Store.
The business plan package is a zipped compressed file containing the PDF, Word and Excel documents. To open the package after downloading it, just right click, and select Extract All. If you have any problems in downloading and opening the files, email us on [email protected] and we will assist you.
We wish you the best in your construction business! Check out our collection of business plans  , and more business ideas .
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Construction Business Plan Template
Written by Dave Lavinsky
Construction Business Plan
You’ve come to the right place to create your construction business plan.
We have helped over 100,000 entrepreneurs and business owners create business plans and many have used them to start or grow their construction companies.
Sample Construction Business Plan Outline
Below is a construction business plan example to help you create each section of your own construction business plan:
Executive Summary
Business overview.
VB Residential Construction Company is a startup construction company located in Milwaukee, Wisconsin. The company is founded by two cousins, Victor Martinez and Ben Schmidt. Together they have over 20 years of experience in constructing homes from design concept, remodeling and renovating homes. They are highly skilled in all aspects of construction and have garnered a positive reputation in the local construction community for their ethical practices and competitive skill set. Now that Victor and Ben have an extensive network of clients and contacts, they have decided to begin their own residential construction company.
Product Offering
The following are the services that VB Residential Construction Company will provide:
	Custom home building/design build
	Home remodeling and renovation
	Project Management
	Kitchen and bath construction

Customer Focus
VB Residential Construction Company will target those individuals and industry professionals requiring home construction services in Milwaukee, Wisconsin. Those individuals are landowners looking to develop homes on their lots, architects who have clients needing homes built, developers who have the vision but need a company to make it a reality, and households needing home remodeling services.
Management Team
VB Residential Construction Company will be led by Victor Martinez and Ben Schmidt. Together they have over twenty years of construction experience, primarily in residential builds, remodeling, and renovation. They both started at a young age working and learning from their fathers. When they graduated from high school, their fathers got them jobs at the construction company they were employed at. The four family members worked together for ten years at the construction company. The fathers recently decided they were going to retire from the industry which prompted Victor and Ben to branch out on their own and start their own residential construction company.
Success Factors
VB Residential Construction Company will be able to achieve success by offering the following competitive advantages:
	Friendly and knowledgeable contractors who are able to take any project from concept to reality.
	Unbeatable pricing – Clients will receive the best pricing in town for services on any project while maintaining the best quality and customer satisfaction.

Financial Highlights
VB Residential Construction Company is seeking $200,000 in debt financing to launch its construction business. The funding will be dedicated towards securing a small office space, purchasing two trucks, and purchasing all the construction equipment and supplies. Funding will also be dedicated towards the advertising agency and three months of overhead costs to include payroll of the staff, rent, working capital, and monthly fees to the accounting and human resources firm. The breakout of the funding is below:
	Trucks: $40,000
	Construction equipment, supplies, and materials: $100,000
	Advertising agency in charge of promotions: $10,000
	Three months of overhead expenses (rent, payroll, HR and accounting firms): $40,000
	Working capital: $10,000


Company Overview
Who is vb residential construction company.
VB Residential Construction Company is a newly established contracting company located in Milwaukee, Wisconsin. Founded by cousins, Victor Martinez and Ben Schmidt, they have over 20 years experience in the construction industry. VB specializes in residential remodeling, kitchen and bath construction, as well as custom home building. VB Residential Construction Company also offers residential design, construction, and project management services. VB prides itself in delivering a level of expert craftsmanship to fulfill the vision for the client while exceeding expectations at exceptional value.
Company History
VB comes from the initials of the owners, Victor Martinez and Ben Schmidt, two cousins who have been working in the construction industry most of their lives. Both of their fathers spent decades as contractors and raised their sons working and learning the construction trade. The four have been working for another residential contractor in Milwaukee and have built and remodeled numerous homes for multiple builders and clients. Now that both of their fathers are retiring from the construction industry, Victor and Ben have decided to start their own residential construction company and use their years of experience, expertise, and contacts to be an independent residential contractor.
Since incorporation, VB Residential Construction Company has achieved the following milestones:
	Registered VB Residential Construction Company, LLC to transact business in the state of Wisconsin.
	Located a small office space to have a physical address for the company as well as a receptionist.
	Reached out to their numerous contacts to include real estate agents, developers, architects, and landowners to advise them on their upcoming construction company in order to start getting construction contracts.
	Began pricing out costs for trucks and necessary construction equipment.
	Began recruiting a team of contractors that cover different areas of construction to include mechanical, plumbing, electricians, and roofing.

The following will be the services VB Residential Construction Company will provide:
Industry Analysis
Revenue for the Construction industry is expected to continue growing over the five years as demand for new housing expands. Revenues are expected to reach $107 billion.
Relatively low interest rates, coupled with rising per capita disposable income, is expected to support individual investment in new homes, providing an opportunity for industry revenue growth over the next five years.
Per capita disposable income is expected to rise steadily over the next five years, while concurrently, unemployment will drop, proving favorable conditions for industry growth.
Housing starts are expected to rise an annualized 2.9% and this growth is projected to stem partly from forward-looking consumers that choose to purchase homes while interest rates are low. Relatively low housing stock and relatively low interest rates are expected to lead demand for industry services to increase over the next five years.
Customer Analysis
Demographic profile of target market.
The precise demographics for Milwaukee, Wisconsin are:
Customer Segmentation
VB Residential Construction Company will primarily target the following customer profiles:
	Households in search of home remodeling services
	Landowners who would like to build homes on their lots
	Architects who have clients that need home building or remodeling services
	Developers who have already partnered with landowners and/or architects and are in search of a residential contractor

Competitive Analysis
Direct and indirect competitors.
VB Residential Construction Company will face competition from other companies with similar business profiles. A description of each competitor company is below.
JM Remodeling
JM Remodeling has been in business in Milwaukee, Wisconsin since 1990. They are a full-service design and build company. JM Remodeling specializes in residential and commercial restoration and renovation including custom carpentry, kitchens, bathrooms, roofing, siding, dormers, additions, home gyms, home offices, porches and decks, and mechanical services. JM Remodeling carries a staff of plumbers, electricians, journeymen carpenters, restoration specialists, roofers, siders, sheet metal workers, and expert estimators. JM Remodeling also has an apprenticeship program to train employees within the company. They are licensed, bonded and insured and also part of the National Association of Remodeling Industry (NARI). JM Remodeling also provides warranties on all their services. The work is guaranteed by labor warranties, factory warranties, and extended warranties.
Cream City Construction
Cream City Construction has more than 50 years experience in home design, remodeling and renovation in the Greater Milwaukee area and Southeastern Wisconsin. The home remodeling services they provide are additions, whole house remodeling, kitchens, bathrooms, lower levels, master suites and historic renovations. Cream City Construction is a design build company that works with the client to create the design plans, generate project costs, and build the project.
Cream City Construction is owned and managed by Todd Badovski and Jim Grote. Together they have decades of experience and have spent years refining the skills required to run a high end, quality driven remodeling company. The majority of their projects come from repeat business or referrals from clients delighted with their previous service. Cream City Construction is also a member of the National Association of Remodeling Industry (NARI) as well as the Historic Milwaukee Incorporated.
Sazama Design Build Remodel, LLC
Former restaurant owner Don Sazama established Sazama Design Build Remodel, LLC in 1987 after becoming a Master Carpenter. He wanted to merge his passions of business and design and expand his skills in carpentry and architecture. Don’s firm has completed over 700 homes and won 11 awards from the Milwaukee Home and Living magazine. Sazama Design Build Remodel builds homes that are modern and luxurious and have completed many large remodels of bathroom and kitchen renovations. Sazama likes to collaborate with firms such as Ivy Interiors and an award-winning landscape designer, Gingko Leaf Studio. Sazama Design Build Remodel can build and design all aspects of a home – from a home office, outdoor entertaining area, serene spas, and inviting kitchens. The team at Sazama is able to do a historic renovation, build or renovate into something modern and posh, or keep it traditional.
Competitive Advantage
VB Residential Construction Company will be able to offer the following advantages over their competition:
Marketing Plan
Brand & value proposition.
VB Residential Construction Company will offer the unique value proposition to its clientele:
	Highly trusted and professional contractors with over 20 years of experience remodeling, renovating, and building homes.
	Unbeatable pricing to its clients – VB Residential Construction Company does not mark up its services at a large percentage. They will offer the lowest prices in town.

Promotions Strategy
The promotions strategy for VB Residential Construction Company is as follows:
Word of Mouth/Referrals
Victor and Ben have built up an extensive list of contacts over the years providing home construction services for numerous highly satisfied clients. Most of the clients are repeat customers and have also referred them to other associates for home projects. These referrals and repeat customers are very likely to use VB Residential Construction Company instead of the previous construction company Victor and Ben were employed at.
Professional Associations and Networking
VB Residential Construction Company will become a member of construction and professional associations such as the National Association of Remodeling Industry (NARI) and the Milwaukee Chamber of Commerce. VB will also become a member in associations where other builders, developers, and architects are a part of. They will focus their networking efforts on expanding their client network.
Print Advertising/Billboard
VB Residential Construction Company will invest in professionally designed print ads to display in programs or flyers at industry networking events. They will also invest in two billboards to display in highly trafficked areas of town.
Website/SEO Marketing
VB Residential Construction Company will utilize the same advertising company that designed their print ads and billboards to also design their website. The website will be well organized, informative, and list all their services that VB is able to provide. The website will also list their contact information and a gallery of pictures that show their previous projects. The advertising company will also manage VB’s website presence with SEO marketing tactics so that anytime someone types in the Google or Bing search engine “Milwaukee residential contractor”, “contractor near me”, or “residential contractor near me”, VB Residential Construction Company will be listed at the top of the search results.
The pricing of VB Residential Construction Company will be moderate and on par with competitors so customers feel they receive value when purchasing their services.
Operations Plan
The following will be the operations plan for VB Residential Construction Company.
Operation Functions:
	Victor Martinez and Ben Schmidt will be the owners and managers of the company. They will oversee all staff, contractors, and subcontractors. They will also act as project managers for every job they receive and handle all pricing and bids to the client.
	Victor and Ben will employ a team of contractors under them that will have an array of skill sets. The contractors will be trained and experienced either in plumbing, mechanical, electrical, roofing, or siding. Not all contractors need to be certified in all trades, but they need to be certified in at least one of the trades.
	Office manager/assistant to be located at the small office. This person will handle all incoming calls, assist with visiting clients, bookkeeping and maintain files.
	Victor and Ben will utilize a third-party human resources company to handle all hiring, onboarding, payroll, and benefits for the staff. The HR company will also handle all employee issues.
	Victor and Ben will also pay a third-party accounting firm to manage all the high level accounting and tax payments.

Milestones:
VB Residential Construction Company will have the following milestones complete in the next six months.
3/1/202X – Finalize contract to lease small office space
3/15/202X – Execute advertising agency contract 4/1/202X – Begin networking and placing bids for construction jobs
5/1/202X – Begin recruiting and hiring team of contractors
5/15/202X – Purchase all necessary construction equipment, supplies, and trucks
6/1/202X – Start on first official job as VB Residential Construction Company
Victor and Ben are highly skilled at project management and residential construction. They are also both certified in plumbing, electrical, and mechanical. In the next few years, they will be certified as Master Carpenters.
Financial Plan
Key revenue & costs.
The revenue drivers for VB Residential Construction Company are the upcharge they will charge to the clients for their services. VB will purchase or subcontract a service at cost and will charge a 15% markup in order to obtain the markup fee. 15% is below the normal 25%-30% that other competing residential contractors charge.
The cost drivers will be the overhead costs required in order to maintain a construction company. The expenses will be the costs to purchase and maintain construction equipment and trucks, payroll and overhead costs for the staff, and rent and utilities. Other expenses will be the cost for the advertising agency, accounting firm, human resources firm, and membership association fees.
Funding Requirements and Use of Funds
VB Residential Construction Company is seeking $200,000 in debt financing to launch its construction business. The funding will be dedicated towards securing a small office space, purchasing two trucks, and purchasing all the construction equipment and supplies. Funding will also be dedicated towards the advertising agency and three months of overhead costs to include payroll of the staff, rent, and monthly fees to the accounting and human resources firm. The breakout of the funding is below:
Key Assumptions
The following outlines the key assumptions required in order to achieve the revenue and cost numbers in the financials and in order to pay off the startup business loan.
	Initial Monthly Average Contract Amount: $20,000
	Growth in Average Monthly Contracts: 10%

Financial Projections
Income statement, balance sheet, cash flow statement, construction business plan faqs, what is a construction business plan.
A construction business plan is a plan to start and/or grow your construction business. Among other things, it outlines your business concept, identifies your target customers, presents your marketing plan and details your financial projections.
You can  easily complete your construction business plan using our Construction Business Plan Template here .
What Are the Main Types of Construction Companies?
Construction companies can be classified according to the type of constructions that they perform. Some are small renovation contractors, others are new home builders and others are commercial construction companies.
What Are the Main Sources of Revenues and Expenses for a Construction Company?
Construction companies get their primary source of revenue from individual contracts for new homes, remodeling projects or commercial projects.
The key expenses for construction companies are office space rent, salaries and wages, and equipment costs. 
How Do You Get Funding for Your Construction Business Plan?
There are many options for financing a construction company like SBA loans, commercial loans, personal loans, or line of credit. There are also equipment funding opportunities that cover expenses associated with necessary tools, machinery and other equipment. Personal savings, credit card financing and angel investors are also popular forms of funding.
What are the Steps To Start a Construction Business?
Starting a construction business can be an exciting endeavor. Having a clear roadmap of the steps to start a business will help you stay focused on your goals and get started faster.
1. Develop A Construction Business Plan - The first step in starting a business is to create a detailed construction business plan that outlines all aspects of the venture. This should include potential market size and target customers, the services or products you will offer, pricing strategies and a detailed financial forecast.  
2. Choose Your Legal Structure - It's important to select an appropriate legal entity for your construction business. This could be a limited liability company (LLC), corporation, partnership, or sole proprietorship. Each type has its own benefits and drawbacks so it’s important to do research and choose wisely so that your construction business is in compliance with local laws.
3. Register Your Construction Business - Once you have chosen a legal structure, the next step is to register your construction business with the government or state where you’re operating from. This includes obtaining licenses and permits as required by federal, state, and local laws. 
4. Identify Financing Options - It’s likely that you’ll need some capital to start your construction business, so take some time to identify what financing options are available such as bank loans, investor funding, grants, or crowdfunding platforms. 
5. Choose a Location - Whether you plan on operating out of a physical location or not, you should always have an idea of where you’ll be based should it become necessary in the future as well as what kind of space would be suitable for your operations. 
6. Hire Employees - There are several ways to find qualified employees including job boards like LinkedIn or Indeed as well as hiring agencies if needed – depending on what type of employees you need it might also be more effective to reach out directly through networking events. 
7. Acquire Necessary Construction Equipment & Supplies - In order to start your construction business, you'll need to purchase all of the necessary equipment and supplies to run a successful operation. 
8. Market & Promote Your Business - Once you have all the necessary pieces in place, it’s time to start promoting and marketing your construction business. This includes creating a website, utilizing social media platforms like Facebook or Twitter, and having an effective Search Engine Optimization (SEO) strategy. You should also consider traditional marketing techniques such as radio or print advertising. 
Learn more about how to start a successful construction business:
	How to Start a Construction Business

Where Can I Get a Construction Business Plan PDF?
You can download our free construction business plan template PDF here . This is a sample construction business plan template you can use in PDF format.
Other Business Plan Templates
Food Truck Business Plan Template
Event Venue Business Plan Template
Construction Business Plan
Ready to start your own construction business? Set yourself up for success by creating a solid business plan. Download this business plan template, with pre-filled examples, to inspire your own plan.
Download a free construction business plan template in PDF or Word doc format
This form will load shortly, thanks for your patience.

What you'll get with this template:
	A complete business plan Unlike other blank templates, our business plan examples are complete business plans with all of the text and financial forecasts already filled out. Edit the text to make the plan your own and save hundreds of hours.
	A professional business plan template All 550 of our business plans are in the SBA-approved format that's proven to raise money from lenders and investors.
	Instructions and help at every step Get help with clear, simple instructions for each section of the business plan. No business experience necessary.
	A Word doc you can edit We don't just have PDF documents that make editing a challenge. Each plan is available in Word format so you can start editing your business plan example right away.

Key sections in this construction business plan:
All of our sample business plans are complete and include all of the sections that bankers and investors expect to see. Every plan includes the following sections:
	Executive Summary : A quick overview of your plan and entices investors to read more of your plan.
	Company : Describes the ownership and history of your business.
	Products and Services : Reviews what you sell and what you're offering your customers.
	Market Analysis : Describes your customers and the size of your target market.
	Strategy and Implementation : Provides the details of how you plan on building the business.
	Management Team : An overview of the people behind the business and why they're the right team to make the business a success.
	Financial Plan : A complete set of forecasts including a Profit and Loss Statement, Cash Flow Statement, and Balance Sheet.

If you're interested in learning how to write a business plan, read our free in-depth guide to writing a business plan , download our free Business Plan Template , and check out LivePlan —our award-winning business planning software.
Looking for a sample business plan PDF? You can download a few PDF examples below:
	Accounting and Bookkeeping Sample Business Plan PDF
	Agriculture Farm Sample Business Plan PDF
	Cleaning Service Sample Business Plan PDF


Need a faster way to write your business plan? LivePlan is the #1 planning tool for over 1 million businesses.

Discover the world’s #1 plan building software
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In this article, you’ll find construction proposal templates for engineering, residential, and commercial construction projects. For a selection of free construction bid proposal forms, see our comprehensive compilation of construction bid templates in Excel, Word, and PDF formats.
Included on this page, you’ll find a residential construction proposal template , a roofing proposal form , an engineering project proposal template , and an equipment lease proposal template .
Simple Construction Proposal Template

This form features a basic design for creating residential or commercial construction proposals. The template includes contact details for owner and contractor, along with sections to outline the scope of the project, exclusions, terms and conditions, and itemized costs. Choose from a fillable PDF form or an Excel template that performs calculations automatically.
Download Simple Construction Proposal Template
Excel | PDF
Commercial Construction Proposal Template

This template provides an outline for creating a commercial construction proposal that you can customize based on project type and scope. Provide clients with a breakdown of proposed schedule phases, preconstruction and construction responsibilities, key team members, relevant experience, and pricing. Attach any supporting documents, such as team member resumes, insurance documents, or a detailed Gantt chart schedule .
Download Commercial Construction Proposal Template
Residential Construction Proposal Template

Create a thorough proposal for a residential construction project. Include a compelling cover letter, experience and qualifications details, proposed home plans or examples of previous projects, and a list of costs for labor and materials. The template also has sections for specifying work and materials not included in the proposal, warranty information, and terms and conditions.
Download Residential Construction Proposal Template
Engineering Project Proposal Template

Provide clients with a company profile, project overview, detailed scope of work, and itemized cost estimate. Create a project timeline that shows target dates for each step — from initial engineering design to the construction phase. The template provides automatic calculations for easy cost estimating. 
Download Engineering Project Proposal Template — Excel
Roofing Proposal Template

This proposal form includes space for an evaluation, scope of work, project specifications, and details on insulation, flashing, adhesives, and other materials you need for roofing jobs. Use the pricing table to list the projected costs for labor and materials, and add your own warranty information and agreement terms for a comprehensive roofing proposal. You can also adapt this template for use on residential or commercial roofing jobs.
Download Roofing Proposal Template
Equipment Lease Proposal Template

Designed for equipment leasing companies, this template provides cost estimation and leasing terms for construction machinery. Include a cover letter and business profile describing your services, as well as a plan to meet the leasing needs for a specific construction project. The template includes space for an itemized list of equipment expenses, and a section for adding terms and conditions.
Download Equipment Lease Proposal Template
Construction Bid Proposal Forms and Resources
Get tips on writing a bid proposal and find related templates, including a request for proposal (RFP) form . Explore our in-depth guide to construction bidding to learn how to win more bids and find resources for commercial, residential, and government construction opportunities. In our management articles, you’ll find a range of construction management tips and templates , from project schedules to budgeting templates and subcontractor documentation.
Easily Manage and Track Construction Proposals with Smartsheet
From pre-construction to project closeout, keep all stakeholders in the loop with real-time collaboration and automated updates so you can make better, more informed decisions, all while landing your projects on time and within budget.
The Smartsheet platform makes it easy to plan, capture, manage, and report on work from anywhere, helping your team be more effective and get more done. Report on key metrics and get real-time visibility into work as it happens with roll-up reports, dashboards, and automated workflows built to keep your team connected and informed.
When teams have clarity into the work getting done, there’s no telling how much more they can accomplish in the same amount of time. Try Smartsheet for free, today.
Unite construction teams through real-time collaboration with Smartsheet.
How to Write a Construction Proposal: Free Template, Examples & 7 Tips
	AEC Marketing
	Educating and Informing

Posted by: Cinthya Soto
As a construction company or contractor, the first step in securing more projects is to craft a compelling construction proposal. This important document not only serves as one of the biggest selling tools for your construction company. However, participating in construction project bids can be a stressful journey. Crafting precise construction bids and submitting them to clients requires dedicated time, resources, and effort. 
To speed up the proposal creation process, we suggest having a construction proposal template ready. This proposal template should include all the essential elements of a winning proposal , so you don’t have to start from zero and should also be customizable, so you can make it your own and add any changes you’d like. 
In this blog, we will teach you how to write an effective construction proposal that stands out from the competition. We will also prove you with examples of construction proposals, top tips to boost your chances of winning the bid, and a downloadable construction proposal template.
What Is a Construction Proposal? 
A proposal for construction is a formal document submitted by a construction company or contractor to a client or project owner. Its purpose is to outline the details of a construction project, including the scope of work, cost estimates, timeline, materials, and other relevant information.
The proposal serves as a key communication tool between the construction firm and the client, providing a clear understanding of the project’s objectives and how it will be executed. Creating a construction proposal is easier when you have an effective construction proposal template you can customize.
What’s the Difference Between a Construction Proposal and a Construction Bid?
The term “construction proposal” is often used interchangeably with “construction bid” and “construction bid proposal.” However, a bid differs from a proposal. Proposals include all the details found in estimates, quotes, and bids but go beyond simple approximations. They are tailored and specific, highlighting the unique value that a construction company can provide to a potential client. 
A construction proposal is used as a persuasive tool to showcase the construction company’s capabilities and convince the client that they are the right choice for the project.
When submitting a proposal, you are likely to face competition from other companies that want to win a client’s business. Therefore, it is crucial to use a compelling construction proposal template and invest time in writing the details of the proposal to effectively showcase the value you can offer. 
On the other hand, a construction bid is used by the project owner to compare different offers from various contractors. After evaluating the bids, the project owner can select the most suitable and competitive bid to award the construction contract.
Bids are specifically common in the construction industry , especially for larger projects. Sub-contractors frequently submit construction bids to general contractors to undertake specific portions of the project. 
To summarize, bids and proposals are very similar, but proposals tend to be more detailed. Both are useful in different situations, and people will continue to use them interchangeably. 
Why Construction Proposals Are Important
Construction proposals are essential for several reasons. A construction proposal is not only about winning clients and making money; it’s also a way to show off your company. It reflects both what makes your company special and its overall image. A construction proposal plays a crucial role in the construction project’s success and the relationship between the construction company and the client. Here are some key reasons why construction proposals are important.
1. Brand Identity and Reputation 
Highlighting the construction company’s brand identity in the proposal reinforces its reputation and credibility. Using custom brand assets , colors, and other customized and personal elements can make a difference between winning or losing a potential client. 
A strong brand identity, built on trust, reliability, and quality, can make you stand out from other bidders and instill confidence in the client and reassure them that they are choosing a reputable contractor.
2. Clarity and Understanding 
A well-written construction proposal provides a clear and detailed outline of the project’s scope, timeline, and cost. This ensures that both the construction company and the client have a shared understanding of what will be delivered and at what cost.
3. Transparency and Trust 
You should define client expectations and be straightforward about what you are going to provide for the client. A comprehensive construction proposal demonstrates transparency in the pricing and cost breakdown. When the client sees a detailed estimate, they are more likely to trust the construction company, leading to better client-contractor relationships.
4. Project and Resource Planning 
The proposal serves as a foundation for project planning and execution. It helps the construction company allocate resources, plan schedules, and coordinate tasks effectively.
5. Client Decision-Making 
For clients, reviewing proposals from different construction companies allows them to compare offerings and select the best-suited contractor for their project. The proposal becomes an important document in the client’s decision-making process.
What Is Included in a Construction Proposal?
A construction proposal will typically include:
	Contact information
	Specification of parties 
	Scope of work 
	Work schedule
	Relevant authorities 
	Cost breakout 
	Terms and conditions 
	Warranty 
	Signature line 

Below, we’ll go into more detail on what information to include in each section.
Additionally, here are some optional construction proposal elements to consider: 
	Exclusions: Provide information about work, materials, or equipment provided by others. 
	Materials: Outline the specific materials that will be used on the project. 
	Labor: Describe the type of labor for the project and how many hours for each.

Equipment: This is useful for contractors that require heavy equipment on the job.
How do you write a construction proposal? 
Writing a construction proposal requires careful planning and attention to detail to ensure that all the necessary information is included. Here’s a step-by-step guide on how to create winning construction proposals : 
1. Specification of Parties 
The first part of a construction proposal is to highlight the details of both parties involved. Identify the parties involved in the construction project, including the construction company (contractor) and the client (owner). 
2. Contact Information 
Make sure to include both your contact information and the clients on the first page of the proposal. Include both parties’ names, logos, addresses, phone numbers, email, and any other relevant contact details. 
3. Scope of Work 
Describe in detail the scope of work that the construction company will undertake. Providing a detailed description of the work you’ll be performing is crucial in any construction proposal. This section should outline all the tasks and activities to be completed. We suggest dedicating a good amount of time to this section, ensuring it is highly detailed and comprehensive by listing all the services and tasks you offer. 
If you plan to use a sub-contractor for certain tasks you won’t be performing, make sure to include their information and estimated cost, clearly outlining the responsibilities of each party involved. These will be the “exclusions” to the scope of work, which includes work that will not be done by the general contractor. 
A thorough scope of work prevents any misunderstandings or unexpected tasks that may arise if it’s not properly outlined. 
4. Work Schedule 
A realistic timeline is essential for successful project management. Present a realistic and detailed work schedule, including start and completion dates for each phase of the construction project. Make sure to include the time needed for obtaining permits and approvals, as well as the steps of work and completion. Remember to account for potential delays due to weather, delivery services, and other external factors beyond your control. 
5. Relevant Authorities 
Identify any relevant authorities or regulatory bodies that the construction project must comply with, such as building codes or permits required. The relevant authorities in a construction project refer to the roles and responsibilities of both your crew members and anyone else with decision-making power. This includes individuals at local municipalities, affiliates, and partners involved in the job. 
6. Cost Breakout 
Also known as administrative breakout, the cost breakout section should provide a comprehensive breakdown of the estimated costs for the entire project. This should include: 
	Labor 
	Materials 
	Equipment 
	Permits 
	Any other relevant expenses 

It’s essential to have a payment schedule outlining how and when the client will compensate you for the work you are performing. 
Normally, the cost should be stated on the first page of the proposal. If your proposal extends beyond one page, include the total cost on the first page and the detailed breakout on the page where it falls naturally. 
7. Terms and Conditions 
In this section, outline the legal and contractual terms and conditions that both parties must agree to before starting the project. This section may cover: 
	Payment terms 
	Insurance requirements 
	Dispute resolution 
	Other important aspects 

The more specific and clear the conditions, the smoother the outcome will be. Both parties must acknowledge and accept the scope of work, costs, and terms in writing to avoid potential legal disputes later in the project. 
8. Warranty 
Specify any warranties or guarantees offered on the completed work. Clearly state the duration and coverage of the warranty. In this section, you outline the specific work you are responsible for fixing and the conditions under which you will do so. Additionally, it clarifies the aspects you are not liable for. 
9. Signature Line 
Lastly, there’s the acceptance of the proposal. Leave space for the authorized representatives of both parties to sign the proposal, indicating acceptance of the terms and agreement to move forward with the project. This will happen if the project owner is satisfied with the construction proposal. The signatures serve as the foundation for a legally binding document between the two parties, confirming their agreement to the terms and conditions specified. 
Construction Proposal Templates 
Here are some construction proposal examples to help you get an idea of what your construction proposal should look like. 
Commercial Construction Proposal Template 

Architecture Firm Proposal Template

Residential Construction Proposal Template

Source: Smartsheet
Roofing Proposal Template

Remodeling Contract Template

Source: Sample
But there’s so much more to learn about the proposal creation process outside of meeting the basic requirements. Here are a few short tips for customizations you can add that make your proposals stand out.

Writing Tips When Using Your Construction Bid Template 
Although there are no guaranteed construction proposal templates that ensure you win every bid, writing customized, detailed, and accurate proposals that showcase your business increases your chances of securing the next project. Here are 7 tips to help you craft a compelling and successful bid proposal:
1. Customize Your Proposal 
Tailor your bid proposal to the specific needs and requirements of the client and the project. Avoid using generic templates and instead, include personalized details that address the client’s goals and objectives. Show that you have taken the time to understand their vision and how your construction company is the best fit for their project.
2. Focus on the Details 
Provide a comprehensive breakdown of the project’s cost estimate, including specific budgeting details. Clearly outline labor, materials, equipment, permits, and any other relevant expenses. Be transparent in your pricing and avoid vague or ambiguous figures. A well-detailed budget inspires confidence in your financial planning and helps the client make an informed decision.
3. Specificity 
Use specific language and avoid vague or general statements. Provide concrete examples and data to support your claims. Specificity adds credibility to your proposal and shows that you have a well-thought-out plan for the project.
4. Show Project Impact 
Highlight the positive impact your construction company’s work will have on the client’s project. Explain how your expertise and approach will lead to successful project outcomes, such as increased efficiency, improved functionality, or cost savings. 
5. Demonstrate You Understand the Client’s Pain Points 
Address the client’s pain points and challenges explicitly in your proposal. Show that you have a deep understanding of their needs and concerns and explain how your construction solutions will alleviate these issues. 
6. Set the Timeline 
Present a clear and realistic timeline for the project, detailing each phase’s duration and key milestones. Ensure that the proposed timeline aligns with the client’s project objectives and any deadlines they have set.
7. Make Sure Your Data is Accurate 
Double-check all the data, figures, and information provided in the proposal. Inaccurate data can negatively affect the client’s confidence in your abilities and professionalism. Accuracy in your proposal reflects your attention to detail and commitment to delivering accurate results. 
Contractor Proposal FAQs 
Here are some questions that may arise during your construction proposal creation journey. 
What to Avoid When Writing Construction Contracts? 
When writing construction contracts, avoid:
	Ambiguous language
	Incomplete scope of work
	Unclear payment terms
	Lack of change order procedures
	Omitting penalties for delays
	Insufficient insurance coverage
	Ignoring local regulations
	Incomplete indemnity and liability provisions
	Unclear warranty terms
	Neglecting dispute resolution mechanisms
	Using templates that aren’t customizable 
	Neglecting signatures and execution dates 

What Should a Construction Proposal Look Like? 
Typically, a construction proposal can be a short one-page document (or a long, more in-depth proposal) that includes the contractor’s contact info, what work will be done (tasks, phases, and things to finish), cost breakdown (materials, supplies, equipment, and labor), payment plan, project schedule, rules, guarantee, dispute resolution, and signatures of both parties.
What Does Proposal Mean in Construction? 
When a customer has a construction project, they create a job posting, and contractors submit their proposals. These proposals are formal documents outlining project details, scope of work, timeline, cost estimate, and payment terms. The proposal serves as a communication tool for the client to assess the company’s capabilities and make an informed decision about the project. The winning contractor is often the one with the lowest bid, making it somewhat like an auction. 
How Do I Write an Independent Contractor Proposal? 
At the very least, a proposal for work, which becomes a legal contract when signed by both parties, must include the following:
	Names and contact information of the owner and contractor
	Work location
	Detailed description of the work to be done (scope of work)
	Cost of the work and payment schedule
	Signatures of both parties and the date 

How Do I Respond to a Construction Request for Proposal (RFP)? 
To respond to a construction request for proposal (RFP) :
	Review the RFP thoroughly 
	Understand the client’s needs 
	Form a response team 
	Include an executive summary 
	Address each RFP requirement 
	Propose a comprehensive approach 
	Demonstrate expertise and past successes 
	Provide transparent budget and pricing details 
	Emphasize quality and safety measures 
	Introduce key team members 
	Include client references or testimonials 
	Use visuals for clarity 
	Proofread and edit your response 
	Submit on time and follow the instructions 

Start Your Proposal for Construction With OpenAsset
To win clients and secure projects for your architecture firm, it’s essential to create compelling proposals. However, we recognize the obstacles you may encounter in this process. That’s why, unlike traditional DAM systems, OpenAsset offers a project-based DAM solution specifically designed for AEC marketers . With dozens of integrations and useful features, OpenAsset is the MarTech you need to create high-converting content, proposals, presentations, and much, much more. 
Get your free downloadable construction proposal template today. And if you’d like to learn more about our DAM technology, you can reach out to our Support team, here or contact one of our digital asset experts today to schedule a demo . 
Get OpenAsset DAM Insights
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Best Practices for Formatting Your Next Proposal 
In our recent webinar, Expert Dos & Don’t’s of Proposal Writing with Rachelle Ray, we received dozens of insightful questions from the a...

Robins & Morton Creates a Strategic Asset Management Process with OpenAsset
The Marketing and Communications team at Robins & Morton is always eager to implement the newest tools and innovations to keep up with t...

Architecture Proposals: Win More Work + Free Template
Architects play a pivotal role in shaping the built environment, and an effective proposal serves as a cornerstone for translating creative ...

Construction Business Plan Template
Construction company business plan template.
If you want to start a construction business or expand your current one, you need a business plan.
Over the past 20+ years, we have helped over 10,000 entrepreneurs and business owners create business plans to start and grow all types of construction businesses, including commercial construction, building construction and residential construction.
Construction Business Plan Outline: How To Write a Construction Business Plan
Below are links to each section of a construction business plan:
	Executive Summary – The executive summary is the most important part of your business plan. It’s where you explain what your business is and why it will be successful.
	Company Overview – This section of your construction business plan should include a brief business description, your vision and mission statement, and the company’s core values.
	Industry Analysis – This section of your plan will provide an overview of the construction industry, including market size, growth outlook, major players, and competitive landscape.
	Customer Analysis – In this section of your plan, you will identify and describe your target market(s).
	Competitive Analysis – In this section, you will analyze your competitors and explain how you plan to differentiate your company from them.
	Marketing Plan – Your marketing plan should include an overview of your marketing goals, strategies, and tactics.
	Operations Plan – Your operations plan should describe how you will produce your product or service, as well as the people and resources needed to do so.
	Management Team – In this section, you will introduce the members of your management team and their experience and qualifications.
	Financial Plan – Your financial plan should include your financial statements such as the income statement, balance sheet, and cash flow statement.
	Appendix – The appendix of your plan should include any additional supporting materials, such as market research reports, resumes, licenses and permits.

Next Section: Executive Summary >
Construction Business Plan FAQs
What is the easiest way to complete my construction business plan.
Growthink's Ultimate Construction Business Plan Template allows you to quickly and easily complete your Construction Business Plan.
Where Can I Find a Free Construction Business Plan PDF Download?
You can download our construction business plan PDF template here . This is a business plan template you can use in PDF format.
What Is a Construction Business Plan?
A construction business plan provides a snapshot of your construction business as it stands today, and lays out your growth plan for the next five years. It explains your business goals and your strategy for reaching them. It also includes market research to support your plans.
Why Do You Need a Construction Business Plan?
The construction industry is tough. If you’re a contractor looking to start a small construction business or construction services company, you need a business plan. A business plan will help you raise funding, if needed, and plan out the growth of your construction business in order to improve your chances of success. Your business plan is a living document that should be updated annually as your company grows and changes. As always, we are here to help you write a business plan and guide you through the steps of taking your business idea from dream to reality.
What Are the Sources of Funding for Construction Businesses?
The main sources of funding for a small construction business are bank loans and angel investors. With regards to bank loans, banks will want to review your business plan and gain confidence that you will be able to repay your loan and interest. To acquire this confidence, the loan officer will not only want to confirm that your financials are reasonable. But they will want to see a professional plan. Such a plan will give them the confidence that you can successfully and professionally operate a business.
The second most common form of funding for a construction business is angel investors. Angel investors are wealthy individuals who will write you a check. They will either take equity in return for their funding, or, like a bank, they will give you a loan. Venture capitalists will generally not fund a construction business.
How Do You Start a Construction Business?
Please see this article on our website: How to Start a Construction Business
What Are the Keys to Success for a Construction Business?
Below are some of the keys to success in the construction business:
	Vision & Focus: determine the type of construction business you want to operate and stick to that vision.
	Create your business plan: Your plan will help you set goals and outline how to achieve them.
	Get licensed, bonded, and insured: before you can bid on your first job, you need to investigate and meet the requirements for local and state licenses and do what you need to do to secure them, get your worker’s compensation and liability insurance, and find out how much you need to be bonded for.
	Build a winning team: Hire and train a team of employees with the right skills. Remember that since construction is seasonal and cyclical, you must also be willing to downsize if/when the workload decreases.
	Purchase wisely: be careful not to overspend on salaries and equipment. Consider renting equipment when possible.
	Properly price jobs: Keep factors such as overhead and actual production costs (materials, labor, inspections, etc.) in mind when pricing jobs to ensure a healthy profit on all projects.
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Construction Proposal Template

Build a professional Construction Proposal Template for your interested clients with Jotform Sign . Include pertinent information like project cost, estimated duration of your project, scope of work, required material, and other details you want included. Send your completed proposal off to your clients to their e-signatures — then receive a finalized PDF once everyone is done signing.
Change up the look and feel of your Construction Proposal Template with our online form builder. Add or remove form fields, switch up colors and fonts, upload blueprints or site images, create an automated signing order, and much more. Get your construction projects approved seamlessly with Jotform Sign.
More templates like this

Free Business Proposal Template
Getting your business off the ground is no small task and might require gathering funding from investors. With Jotform Sign’s free business proposal template, you can present your new business’s needs, ideas, and benefits to potential investors — making it easier to get their buy-in. A business proposal template is a tool for entrepreneurs to quickly and effectively create professional business proposals without having to start from scratch. Just create and customize your proposal, then send it to your investors and other stakeholders for their e-signatures.Need to make changes to your business proposal template? No problem! With Jotform, you can drag and drop elements to personalize your proposal and match your company branding. You can add or remove form fields, create an automated signing order for multiple investors, upload logos and branding, and choose fonts and colors that work best for you. Work smarter with Jotform Sign!

Free Project Proposal Template
Don’t waste time creating multiple project proposals from scratch. With Jotform Sign’s ready-made Project Proposal template, you can generate and customize a professional-looking proposal that includes details such as an overview and description of the project, resources and budget, project goals, expected outcomes, and more. Update the wording however you see fit, then share it with clients via email to seamlessly gather e-signatures from any device.Want to personalize this Free Project Proposal to match your company’s branding with Jotform White Labeling? No problem! Using our powerful online builder, you can add or edit form fields, upload your logo and branding, include images, change fonts and colors, and make other design changes without any coding. Once both you and your client have signed this proposal, you’ll automatically receive a finalized document — ready to share, download, and print for your records.

Mobile App Development Proposal Template
Create a Mobile App Development Proposal Template that works for all occasions with Jotform Sign. With our entirely online signature and feedback collection process, you’ll be able to manage and reference signatures from your team members in one convenient place. Share via email or embed in your online team portal.Customizing this Mobile App Development Proposal Template is simple and efficient with Jotform Sign. Update the terms and conditions, add or remove form fields, change fonts and colors, and make other cosmetic changes with no coding required. Create your app proposal, send it straight to your team, and start collecting signatures and feedback instantly. Collaborate smarter with Jotform. To collect e-signatures on any device, create an e-sign document with Jotform Sign.
These templates are suggested forms only. If you're using a form as a contract, or to gather personal (or personal health) info, or for some other purpose with legal implications, we recommend that you do your homework to ensure you are complying with applicable laws and that you consult an attorney before relying on any particular form.
Your account is currently limited to {formLimit} forms.
Go to My Forms and delete an existing form or upgrade your account to increase your form limit.
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FREE 10+ Construction Business Proposal Samples in PDF | MS Word | Pages | Google Docs

Infrastructure is no joke as the amount of time, resources, and funding they require range in the hundreds of thousands, at least. That is why companies make sure that the previously mentioned expenses don’t go to waste by meticulously observing the construction business proposals used to present these ideas. As such, if you’re aiming to get that sweet yes from investors, your project needs to be impactful, effective, and practical.
Construction Business Proposal
1. construction business proposal template, sample construction business proposals, 2. construction business proposal sample, 3. construction business proposal request template, 4. construction business proposal and analysis sample, 5. construction business proposal template, 6. construction project business proposal sample, 7. standard construction business proposal template, 8. small project construction business proposal, 9. construction project management proposal sample, 10. formal construction business proposal sample, 11. construction business proposal in doc.

	Google Docs

Size: A4, US
Presenting a construction project proposal is beneficial for any business. This method allows investors to inspect the plan and ensure that  risk assessment , structural stability, and practical financial management are all taken into consideration. So, if you want to make an impactful presentation, check these construction proposal samples out for ideas and concepts.

Size: 271.8 KB
If you want your presentation to be hard-hitting, you need to make sure that your audience or reader can follow your ideas at a comfortable pace. To achieve this, all you have to do is break apart the entire  project proposal  into more easy-to-handle parts. Take, for example, this  Construction Business Proposal   Sample  that divides its text into modules. These breaks give your paragraphs breathing room and keep your proposal from turning into a wall of text that—let’s be honest—no one wants to read.

Size: 53.3 KB
Several businesses and even the government utilize proposal requests. These entities also send these documents out when purchasing products and services for building infrastructure. Construction companies, in return, have two options: to either respond and send a  project proposal letter  or pass it on to someone more capable. When you need an RFP, use this  Construction Business Proposal Request Template  to your advantage. This sample provides the necessary text that is distinct from RFPs.

Size: 1.4 MB
When creating your building construction business proposal, it’s also best to utilize a  financial analysis . This method ensures that you’re using the most valid and most accurate information available to you. In fact, by using this  Construction Business Proposal and Analysis Sample  as a reference, you can accurately see the benefits of a well-executed analysis. This free sample analysis is viable for both small business and huge entities, and is convenient to download, so what are you waiting for? Click the button now, and enjoy both convenience and high-quality work.

Size: 188.4 KB
A construction business proposal is no different from any other business proposal. It still needs to be impactful, eye-catching, and practical all at the same time. In fact, as  Steve Wanker once said in an interview  with Business Insider, “When approaching a business proposal, you need to have both heart and skepticism.” And the same remains true for this  Construction Business Proposal Template . This free sample is easy to use, provides compelling text, and is an excellent template for achieving the previously-mentioned objective.

Size: 1.3 MB
A compelling construction business proposal should be akin to a  SWOT analysis . It must approach weaknesses and threats from multiple angles, and efficiently resolve them, utilizing your strengths and through effective use of opportunities. Hence, sample construction project proposals—such as this  Construction Project Business Proposal —that have these traits make excellent templates to use. This PDF file, in particular, categorizes information into sections for convenient reading and breathing room for the text. So what are you waiting for? Click the download button now!

Simple proposals  that have a generic layout are a useful tool that most construction companies utilize. For example, this  Standard Construction Business Proposal Template  has a very straightforward approach that makes it an outstanding template. The generic layout may not be as flashy as most other proposals, yet this opens you up to multiple creative possibilities. It’s free to use and easy to understand, so click the download button now to enjoy this excellent document.

Size: 2299.1 KB
Despite the layout more closely resembling a  progress report , this  Small Project Construction Business Proposal  is a viable template to use. As its name suggests, this sample is most effective when you need a model for something small-scale yet isn’t ideal if you need a road construction business proposal, for example. Free and easy to use, click the download button now and enjoy the services this document can give you.

Size: 21.9 KB
A  construction management plan  is one-half of a project’s success, with the other half being its implementation. As such, this is an essential part of any construction project’s resources. Inform your higher-ups and business team of an on-site supervisor’s importance by using this  Construction Project Management Proposal Sample  as a guide for your draft. What makes this template perfect for the job is its reliable yet understandable text, its easily editable layout, and the fact that it’s free. So, what else do you need? Download and try out this template now.

Size: 7.6 MB
Formality in the context of building design can range from  presenting your proposal to win  investors, to submitting a construction business proposal letter in response to an RFP. Whatever the plan is, if you aim to propose your infrastructure concept professionally, then this  Formal Construction Business Proposal Sample  is your best asset. This template is free and includes pre-formatted text, so what are you waiting for? Click the download button to avail of this marvelous template conveniently!

Size: 20.0 KB
Word processor formats, such as Microsoft Word or Google Docs, are readily available and easy to access. Subsequently, a template like this  Construction Business Proposal in DOC  becomes more viable as this document is easy to edit using the previously mentioned formats. This  professional proposal sample  is easy to download, free to use, and saves you much time drafting your layout by providing one for you.
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Construction Proposal Template
This Construction Proposal template will help you get up and running quickly by including important sections win the next bid. Whether you do commercial or residential construction, this is the perfect template to both impress your client and quickly close the deal.
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Building Construction
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Construction Logistics Proposal
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How to Write a Construction Business Proposal
	Specifically state your client as well as your company so as to make clear who the parties involved are.
	Also state the address of the site project, so that all involved know exactly where the project is located.
	The most important thing is to specify what you are providing to the projects, whether materials and/or labor.
	Then include an estimated cost of the requirements for the project.

Why Would You Want to Use a Construction Business Proposal?
	Ease of writing, as it is fairly simple to customize a given template for specific instances so as to make specific documents.
	Ease of acquisition, as it is fairly easy to get your hands on these documents, and then to produce them so as to use them yourself.
	Ease of presentation, as you can produce documents that can get your point across fairly easily.

Construction Company Sample

Construction Supply

Continuity Plan Proposal

Global Construction

Example of Construction Proposal

Tips for Making Business Proposals
	Be sure to be specific regarding what you contribute. This would allow you to establish limits on what you can and cannot provide, so as to avoid disputes later on.
	Make sure that you also specify what the job requires. If not, you may be called upon to perform tasks you are not prepared for.
	Never forget to include the address of the project. This ensures that you have put down the address correctly, and lets you prepare accordingly.
	Make sure to double check so that you can make sure that you have proper estimates of the job, and your capabilities.
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Contractor Proposal Template

Free Contractor Proposal Templates
	• Cover letter
	• Services table
	• Payment terms

What is a contractor proposal?
A proposal document will include information about the tradespersons’ skills, experience, services, and price.
Proposals can get repetitive as tenders require similar information for each project. That’s why contractors will often use a contractor proposal form or template where they merely update the document for each submission.
DISCLAIMER : We are not lawyers or a law firm and we do not provide legal, business or tax advice. We recommend you consult a lawyer or other appropriate professional before using any templates or agreements from this website.
Get access to our Contractor Proposal Template (Free Download)
Why is a contractor proposal important, why you need to go beyond an estimate to win business and construction bid, get access to our contractor proposals (free template download), the elements of a winning contractors proposal template, 1. ask quality questions to understand the project.
	• What's the spec and design of the project?
	• Who is the main point of contact for the job?
	• What is the expected timeframe of the construction?
	• How many contractors will I be working with?
	• What is your budget?

2. Keep your proposal simple
3. be specific with your services, contractor proposal faqs, contractor proposal, prepared by, prepared for, _____________ services, payment terms, related proposals and templates.
	Construction Contract Agreement Template
	Subcontractor Agreement Template
	Independent Contractor Agreement Template
	Painting Proposal Template
	Remodeling Agreement Template

Get access to our Contractor Proposal (Free Template Download)
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Moscow International Business Centre (MIBC)
The Moscow International Business Centre (MIBC) is an ambitious engineering project in the centre of Moscow. The site is
Estimated Investment
$12 billion
Construction Started
Moscow, Russia
Project Type
Business complex (city within a city)
CITY JSC, Moscow City Government

The Moscow International Business Centre (MIBC) is an ambitious engineering project in the centre of Moscow. The site is on an old urban area near the river embankment. The goal of the project is to create a new business district within the city.
The whole complex is to be built on a 100ha site (divided into 30 plots) designated for new development on the Krasnopresnenskaya embankment. The management company for the project is CITY Joint Stock Company (CITY JSC), a company first set up in 1992 as a collaboration between the Russian government and private investors.
Recommended White Papers

Vals Quartzite
Vals quartzite: applications for floor, bathroom and wall, recommended buyers guides.

Stone and marble solutions for the architecture industry 
Glass solutions for the architecture industry.
The project was first launched in the early 1990s but has been stalled for much of the last 10 years due to a lack of investment. In 2003 the project started to attract investment again and has been gaining momentum ever since.
PLOT 1: BAGRATION BRIDGE AND TOWER 2000 OFFICE COMPLEX
The first major building constructed in the MIBC project on Plot 1 was the Bagration Bridge (pedestrian bridge) and mall, completed in 1999. The second project was the Tower 2000 office complex, a multi-use business complex begun in 1996 and completed in 2001. The building is 106m high and has 30 storeys above ground and four storeys below. The total floor area of the complex is 60,000m².
The underground area contains parking garages, restaurants, retail areas and a fitness centre. Floors 3–15 and 17–26 are business offices while floors 8 and 27 have a media centre, large exhibition hall and piano bar.
The business areas are served by structured cable network, fibre optic cable, satellite broadcasting, Wi Fi and ADSL Internet access, automatic digital telephone exchange with integration of services, local broadcasting system, municipal broadcasting network, electric timing system, data collection and processing system, audio and video systems, simultaneous interpreting system, conference system, video projection system and security systems including biometric access control and a monitoring system.
The tower also has a central air conditioning system, auxiliary exhaust ventilation system, cooler and heat supply systems, Uninterruptible Power Supply system (UPS), automatic fire security system, automatic volumetric fire-fighting system, sprinkler system and automatic smoke removal system.
The general contractor for the tower was Promstroytechnologia-M Company Ltd. The facade of the tower, which is made of glass and structured concrete, was constructed by Transwall Technology. The tower is equipped with 17 computerised rapid elevators, supplied and installed by Schindler Aufzuege AG, and an outer panoramic elevator, supplied and installed by Kone Lifts. The exterior lighting equipment was supplied and installed by Thorn.
PLOTS 2 AND 3: MOSCOW WEDDING PALACE AND CITY SQUARE
The sites designated by plots 2 and 3 are now to be developed as the Moscow Wedding Palace and City Square. This will include a city square, an underground retail complex and a 14 storey multipurpose complex, which will include the Wedding Palace, banquet halls, restaurants, shops and a hotel.
The developer is Capital City Developments. The architect is Mosproject – 2. The construction started in 2005 and is scheduled to be complete by the end of 2007.
PLOT 4: AQUAPARK
The Aquapark leisure complex was started in 2002 and was completed in 2005. The site occupies a 1.74ha area adjacent to Krasnopresnenskaya embankment. It includes:
	Complex of swimming pools, water mountains and leisure attractions, restaurants and cafes and retail areas (24,352m²)
	Five-star, 30-storey hotel complex (54,640m²) built on a six-storey podium containing retail areas, restaurants and nightclubs
	Parking to accommodate 425 vehicles (13,050m²)
	The aqua park will be connected with a mooring on the Moscva River

The developer of the complex was Aqua-City Palas Company Ltd. The project required an estimated investment of $230 million. The general contractor was Liard Stroy Ltd and the designers were Mosproekt-2 of Russia and Tkhomesto Engineering of Finland.
PLOTS 6, 7 AND 8: UNDERGROUND MALL AND METRO STATIONS
A large underground complex containing the central core of the MIBC, an underground mall and two metro stations is located on these plots. Construction started in late 2001 on the 5.1ha site and was completed in mid-2004. The complex has a total floor area of 150,000m² and includes:
	35,000m² shopping mall
	20,000m² multi-purpose performance complex
	10,000m² dancing complex
	15,500m² sports and leisure complex
	30,000m² ‘Wonderful World of Entertainment’ theme park
	7,000m² restaurant complex
	30,000m² hotel

The complex developer was CITY JSC and the designers were Mosproekt-2. The construction engineers were Bovis Europe and Jones Lang Lassale of the UK.
PLOT 9: CAPITAL CITY PROJECT
This project involves the construction of two connected tower blocks and a dome. The towers will be of 73 and 62 storeys high, with a 16-storey domed building containing an atrium. Connecting the buildings will be a podium building with three storeys above ground and 4–6 below ground.
The lower levels of each tower will be for office space (200,000m²), while the upper levels (above 80m) will be residential and the dome will be used as a retail area. The investment for the project is $250 million.
The developer is Capital Group; the construction engineers are Bouygues Construction and the architects are Erick van Egeraat Associated Architects of Holland. Construction has been underway since 2005 and the project is scheduled for completion in mid-2007.
PLOT 10: NABEREZHNAYA TOWER
This project involves the construction of a new office and apartment complex consisting of three A-Class buildings 16 (86m), 27 (135m) and 52 (250m) storeys high, with a total floor area of 220,000m². The construction began in mid-2003 on the 2.55ha site with the smallest of the three buildings.
The first building was completed in autumn 2004. Enka, a Turkish construction company , is carrying out the development and construction. Enka has invested a total of $150 million so far. Work is continuing on the other two buildings with completion expected in 2007.
PLOTS 11 AND 12: MIXED-USE TOWER BLOCK
The major project on these plots will be a 300m, 75-storey, mixed-use tower block with over 204,000m² of floor space. The facilities will include commercial and government offices, residential areas, retail space, leisure and health centres and a four-star hotel.
Offices will occupy the floors 4–45, while apartments are on floors 48–66. The building was designed as a two-tier skyscraper, 30 floors in the first tier and 37 in the second one. The second floor of the building will be occupied by a casino. The 47th floor will be occupied by a gymnasium.
The designers for the project are Swanke Hayden Connell Architects and the investors are Techinvest, who are investing $270 million. The contractors for the construction are Summa, a Turkish development company. Groundwork was carried out by Kaskatas. Construction on the building started in the third quarter of 2004 with completion scheduled for late 2006.
PLOT 13: FEDERATION OFFICE COMPLEX
The Federatsiya (Federation) office complex is to consist of two towers, one 57 storeys high and the other 87 storeys (345m), and a podium. The 87-storey tower will hold offices and the 57-storey tower will include residential apartments and a hotel. The total floor area of the complex will be 240,000m².
The podium will have three to five levels and 30,000m² of floor space and will contain retail areas, banking facilities, cafes, restaurants and leisure facilities. The complex will have 14 lifts built between the two towers, including four ‘Shuttle’ round-observation lifts.
Stroimontage and NIKoil Financial Group will invest more than $500 million in the project. The architects for the project are P Schweger, S Tchoban and A Asadov of Germany. Stroimontage is the general contractor for the project. Construction started in April 2004 and the complex is scheduled for completion by 2008.
PLOT 15: CITY HALL AND DUMAS
Plots 2 and 3 are owned by the Moscow City Government and original plans were for the new City Hall and Dumas (Parliament) buildings to be located there. However, these buildings will now occupy Plot 15.
The construction on Plot 15 consists of four 70-storey interconnected 308.4m buildings. The project started in November 2005 and will be finished by the end of 2007.
It is expected that all government administration will be accumulated in the new complex to provide better organisation, allowing the buildings currently in use to be sold.
The four skyscrapers will be connected by several two storey bridges between towers and eight storey bridges at the top. The highest bridges will be built in shape of letter ‘M’ for ‘Moscow’.
PLOT 16: RUSSIA TOWER
Plans for a 600m-tall tower to be built in Moscow to designs by British architect Sir Norman Foster were released in March 2006. ST Towers is the developer behind the project and is part of the ST Group.
The Russia Tower will be more than 50% higher than the Empire State Building and is to be built within the Moskva-City development on Plot 16 near the site’s border with the Third Ring Road. It will overshadow the 430m Federation Tower under construction at Moskva-City, which developers say will be the tallest building in Europe when it is completed in 2008.
The 420,000m² tower is a striking design comprising three blade-like structures arranged in a trefoil-like plan around a central core and tapering sharply toward the top, with part of the steel structure exposed on the outside like an exoskeleton.
Described by the architect as a vertical city, the tower is to house parking and retail space on nine underground levels, a public ice rink on the first floor under a spacious, pyramidal atrium, a hotel with serviced apartments above, 24 floors of office, high-end apartments on the top levels and a public observation deck at the very top. The resident population of the tower could be 25,000.
The Russia Tower is billed as an environmentally friendly project, maximizing natural ventilation and lighting, with solar cells, the collection of rainwater and snow to reduce water demand and the recycling of energy between areas with varying levels of demand. In addition, atria several floors high are to be spaced throughout the building’s central core and decorated with plants, providing the luxury apartments on the upper floors with private gardens in the sky.
The construction of the tower is expected to cost about $1.5 billion; of this about $150 million to $200 million would be supplied by ST Towers. Plans for the tower have been approved and it should be finished by about 2010. Construction has not yet started.
PLOT 17 AND 18: MULTI-PURPOSE OFFICE-HOTEL COMPLEX
The multipurpose complex will include two towers (80 and 78 floors), with a common underground space for parking. The high tower will contain office premises and the second tower will be a hotel.
The complex will also contain a roof-top restaurant with a panoramic view, cafes and bars, conference halls and billiard club. The architect is Skidmore, Owinds, and Merrill LLP. No dates have yet been announced.
PLOT 19: NORTHERN TOWERS
An office complex is being developed on this plot by ZAO Severnaya Bashnya. The Northern Towers will consist of three buildings – two 12-storey and one 29-storey. These will contain 135,000m² of floor space.
The architect is Project Institute 2 and the construction engineer is Bau Holding Strabag AG (Austria). Interior design in the building will be carried out by ABD Limited, and legal services with regard to lease documents are provided by PricewaterhouseCoopers.
The first phase of Northern Tower is scheduled for shell and core delivery by the fourth quarter of 2006. The marketing and leasing campaign has already started. Raiffeisenbank has agreed to become the first tenant of the complex.
Northern Tower will feature spectacular atriums, prime office premises and a multi-level parking for 688 cars. There will also be a multi-functional conference hall for up to 200 people, banking premises, restaurants and cafes, a fitness centre with a swimming pool operated by Reebok, a professional dental clinic and a beauty parlour.
POWER PLANT CONSTRUCTION
The power supply for the new MIBC has been a subject of much contention among foreign investors. The complex requires an efficient power distribution system operating at 20kV rather than the more typical 10kV.
CITY JSC and power supplier Mosenergo JSC put forward a proposal in 1999 to the Moscow City Government to develop a new power network for the MIBC, mini-metro, metro junction core, Eurostation and Sheremetyevo-Moscow Rapid Transit System.
The power and heat supply for the MIBC will be provided from three sources: the Mosenergo power station ‘SS-CITY-1’; the district heat and power station ‘Krasnya Prsnya’; and the MIBC power plant on Plot 7A, which entered its first phase of construction in 2002–2003 and is now well into its second phase with completion expected in 2006.
Having established the power supply sources, the next part of the project was the bulk power and distribution network to support the MIBC. Phase 1 of the MIBC power plant has seen the construction of a Gas Turbine Unit (GTU) and Heat and Power Plant (HPP) with a capacity of 50MW and a substation with two transformers for 110V from 20kV and 110V from 10kV and two 63MVA distribution units. The next phase will see an increase of capacity up to 100MW.
The developers of the power plant are CITY JSC and CITY-ENERGO Company Ltd. The contractors for the project are Liard-Stroy Ltd and the designers of the plant were Mosproekt-2 and VNIPI Energoprom.
TRANSPORTATION CONSTRUCTION
The Moscow–Sheremetyevo line is the first phase of the RTS to connect the three satellite airports to the centre of Moscow. This first line, 34.3km in length, will provide interconnectivity between the airport, regional centres and urban junctions and also interconnect with the existing municipal transport system. The project was started in 2001 and eight stations were planned. This stage is now complete.
The developer for the RTS is CITY JSC in collaboration with the City of Moscow; the designer is SNC Lavalin of Canada. The Phase 2 section of the project to extend the line to cover Vnukovo Airport was started in 2004 and is now nearing completion (scheduled to open in 2007).
The RTS development not only concerns rail links to the new commerical centre of Moscow but it is also a development in its own right. The Plot 11 development will include the construction of the new Moscow transport terminal uniting the RTS, three lines of the underground and the intercity bus terminal.
The complex will include transport stations with waiting rooms, boarding areas for VIPs, a hall of customs inspection, left-luggage offices, a 342 room hotel and ticket offices.
For this section of the development Citer Invest B.V. of the Netherlands is the developer, Behnish and Behnish Architekten of Germany are the architects. The investment is $200 million and construction is underway with an expected completion in 2007.
MINI-METRO LINE
A mini-metro line was also constructed to provide transportation within the MIBC and to connect with the historical centre of Moscow. There are three stations, one constructed in Phase 1 of the project and two in Phase 2. The three stations are Dorogomilovskaya, International and Moscow – City.
The length of the line is 5.85km. The engineering and transport contractors were Metrogiprotrans JSC. The line along with the International and Moscow – City stations came into operation in September 2005.
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Federation Tower / Tchoban Voss Architekten + SPEECH + SCHWEGER ARCHITEKTEN

	Curated by María Francisca González
	Architects: SCHWEGER ARCHITEKTEN , SPEECH , Tchoban Voss Architekten
	Area Area of this architecture project Area:  442915 m²
	Year Completion year of this architecture project Year:  2017
	Photographs Photographs: Dmitry Chistoprudov
	Manufacturers Brands with products used in this architecture project Manufacturers:   Atlas Schindler , Boon Edam , Cox , GEZE , RDK , Yuanda , thyssenkrupp
	Lead Architects: Peter P. Schweger, Sergei Tchoban
	General Contractor : Renaissance Construction
	Interiors : SPEECH
	Construction Management : Turner Construction
	Project Documentation:  Tchoban Voss Architekten, SPEECH
	Structural Engineering:  Thornton Tomasetti
	Owner/Developer:  ZAO Bashnya Federatsiya
	City:  Moskva
	Country:  Russia
	Did you collaborate on this project?


Text description provided by the architects. Federation Tower is a complex consisting of two skyscrapers – the 63-storey Tower West and the 97-storey Tower East – on lot 13 of the Moscow International Business Centre in Moscow. The two towers stand on the same mixed-use plinth. The most recognizable high-rise landmark in Moscow, Federation Tower has a memorable silhouette in the form of two glass sails which face one another.

The Federation Tower complex ascends to 374 meters (in 2017 the Council on Tall Buildings and Urban Habitat – CTBUH – recognized it as the tallest skyscraper in Europe). The design is based on the concept of the vertical city, which was realized here for the first time in the history of modern Russia. Each of the towers has a combination of office and residential floors, interspersed with sports and entertainment functions. The six-storey plinth likewise has offices and a shopping gallery. There are more public facilities on the upper floors of the both towers: a restaurant, an observation deck and a multifunctional public space for events.

The basis of the foundations of the Federation Tower complex is a massive concrete slab. Both buildings rely for their stability on a mighty concrete core whose walls are 1.4 meters thick at its base, as well as on 25 perimeter columns extending all the way through the towers from the foundations to the top storeys. Each column has a base measuring 2 x 1.4 meters. Every 25-30 storeys there are outrigger storeys made from high-strength steel structures. The façades have been glazed using the very latest glazing systems: the surface of the glass reflects the sun’s rays while preserving the optimum temperature in the building. In terms of density, the glass comes close to the thermal performance of a brick wall. At the time when use of the latter technology began at Federation Tower, it was being used in no other skyscraper in the world.
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Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
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Here are 7 tips to help you craft a compelling and successful bid proposal: 1. Customize Your Proposal. Tailor your bid proposal to the specific needs and requirements of the client and the project. Avoid using generic templates and instead, include personalized details that address the client's goals and objectives.
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Where Can I Find a Free Construction Business Plan PDF Download? What Is a Construction Business Plan? Why Do You Need a Construction Business Plan? What Are the Sources of Funding for Construction Businesses? How Do You Start a Construction Business? What Are the Keys to Success for a Construction Business?
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Cloned 21,085 Build a professional Construction Proposal Template for your interested clients with Jotform Sign. Include pertinent information like project cost, estimated duration of your project, scope of work, required material, and other details you want included.
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2. Developing a Business Plan. Introduction to Business Planning. What is a Business Plan: The primary value of your business plan will be to cerate a written outline that evaluates all aspects of the economic viability of your business venture including a description and analysis of your business prospects.




	FREE 10+ Construction Business Proposal Samples in PDF
File Format. DOC. Size: 20.0 KB. Download. Word processor formats, such as Microsoft Word or Google Docs, are readily available and easy to access. Subsequently, a template like this Construction Business Proposal in DOC becomes more viable as this document is easy to edit using the previously mentioned formats.




	FREE Construction Proposal Template
Creating a construction proposal has never been easier with our construction proposal template. Whether your business is residential or commercial construction, our template will help you craft a pitch to show off your company's experience. The template includes sections to showcase past projects, define services, execute a contract, and more.




	Free Construction Proposal Template
Download the free construction proposal template that suits your business type, to create a construction proposal that reflects your brand and catches the customer's eye. Get contracts with new clients. Complete and customize the simple construction proposal template to give prospective clients all the details they need to hire you for the job.




	12+ Construction Business Proposal Templates
Download Now. This can apply to a business proposals, if you need to propose going into business with another party, as is often the case with construction businesses. In your case, you might have to send a proposal to propose your company as suitable for a particular task, for which you might need templates to make the job easier.




	Free Contractor Proposal Templates
Why you need to go beyond an estimate to win business and construction bid. Get access to our Contractor Proposals (Free Template Download) The elements of a winning contractors proposal template. Yes, we've made our template in Word file type so you can make changes as you see fit. What is an eSignature?




	PDF HDFL Construction Business Plan Example
Business. HDFL Construction builds two to three custom homes per year. The company works to keep overhead and employee costs low in order to provide homes in a rural setting from $120,000.00 to $140,000.00 in Landholders County. In reviewing statistics in the Landholders County area, the average family income.




	PDF 10 Steps to Building a More Profitable Construction Business
STEP 1: Estimating for Profit Creating a detailed, accurate estimate for the work you propose to do is the first step toward achieving real profitability—yet too many contractors fail to calculate the true cost of a proposed project based upon three essential elements: overhead, risk and job costs.




	PDF ctbuh.org/papers
Capital Group, a Moscow-based company responsible for more than 5 million square meters (53.8 million square feet) of residential, commercial and mixed-use development, Capital City's completion represents an exchange of high-rise design and construction expertise that will influence future construction and building standards in Russia. Authors




	Moscow International Business Centre (MIBC)
The Moscow International Business Centre (MIBC) is an ambitious engineering project in the centre of Moscow. The site is on an old urban area near the river embankment. The goal of the project is to create a new business district within the city. The whole complex is to be built on a 100ha site (divided into 30 plots) designated for new ...




	Federation Tower / Tchoban Voss Architekten + SPEECH
Completed in 2017 in Moskva, Russia. Images by Dmitry Chistoprudov. Federation Tower is a complex consisting of two skyscrapers - the 63-storey Tower West and the 97-storey Tower East - on lot ...




	Federation Tower
Federation Tower is a complex consisting of two skyscrapers - the 63-storey Tower West and the 97-storey Tower East - on lot 13 of the Moscow International Business Centre in Moscow. The two towers stand on the same mixed-use plinth. The most recognizable high-rise landmark in Moscow, Federation Tower has a memorable silhouette in the form ...




	Create a form in Word that users can complete or print
Show the Developer tab. If the developer tab isn't displayed in the ribbon, see Show the Developer tab.. Open a template or use a blank document. To create a form in Word that others can fill out, start with a template or document and add content controls.
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